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Abstract: 
 Interleukin-11 (IL-11) is a multifariously cytokine of great therapeutic interest, especially for 

hematopoiesis, inflammation, and management of fibrosis. Recombinant human IL-11 (rhIL-

11) has been applied extensively in clinical use for the prevention of thrombocytopenia and 

other immune disorders. Nevertheless, the stability and bioactivity of IL-11 formulations are 

affected by their physical and chemical interaction with excipients during formulation. This 

study investigates the interactions of IL-11 with usual excipients, lactose, sucrose, trehalose, 

mannitol, and sorbitol using the molecular docking method. Binding affinities and interaction 

modes were thoroughly investigated to forecast the excipient function in stabilizing IL-11. 

Findings indicated that sugars such as lactose, trehalose, and sucrose exhibit higher binding 

interactions (-6.1, -5.8, and -6.0 kcal/mol) compared to sugar alcohols (mannitol and sorbitol), 

suggesting their viability as more efficient stabilizers for IL-11 in drug formulations. This 

computational strategy underpins the rational choice of excipients for cytokine stabilization 

and can inform future formulation design.  
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CHAPTER 1 

 

 

INTRODUCTION 

 

 

1.1. Overview of Therapeutic protein Formulation  

Improving the storage stability of lyophilized recombinant human interleukin-11 using 

combinations of disaccharides and hydroxyethyl starch. Protein-based therapies are a priority 

for most pharmaceutical companies in the contemporary drug discovery (R&D) age. 

Recombinant biologics have been broadly utilized as the drug of choice for the therapy of 

diverse diseases, in significant part because of specificity in recognizing and altering disease-

related pathways [1]. The first recombinant protein developed for health care application was 

Insulin, marking a significant milestone since its discovery in the 1970s. Initially, non-antibody 

protein-based therapies began with insulin, which was extracted from the pancreas of animals 

such as cows and pigs. In 1922, it was administered to patients with type I and type II diabetes 

mellitus, offering new hope for managing the disease. It was the 1st paradigm shift. DM-I is an 

illness whose basic aetiology is reduced level of insulin, which sends signals to the cells in 

order for the cells to execute functions involved in glucose metabolismDespite its significance, 

the use of insulin was restricted by factors such as limited availability, high production costs, 

and the risk of triggering immune responses. It took nearly six decades before the next major 

breakthrough occurred — the development of Humulin, the first recombinant human insulin 

produced through genetic engineering, which received approval from the US FDA in 1982. 

In pharmacology, protein-based therapeutics are the medications that are emerging the fastest  

[2]. Recombinant technology helps in making a majority of protein therapies, and more than 

170 of them are used in medicine worldwide. However, many more are under clinical trials for 

a variety of uses, including disease management, immunological disorders, infections, cancer 

prevention, and diagnosis. These proteins have become an important part of the pharmaceutical 

business, and research will be done on them to find new, effective treatments  [3]. It has been 

recognized that these treatments make up one-third of the substances approved as novel 

biological medicines. The emergence of SARS-CoV-2 has led to more than 6 million deaths 

worldwide, making it the most severe global health emergency since the influenza pandemic 

of 1918.[4]. 
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1.2 Interleukin-11 (IL-11): Clinical and Pharmaceutical Importance 

A cytokine produced from stromal cells, INTERLEUKIN-11 (IL-11), has potential 

thrombopoietic effects in vivo. [5] [6], Recombinant human IL-11, or rhIL-11, has shown 

promise in clinical trials as a treatment for thrombocytopenia brought on by chemotherapy. 

RhIL-11 improves platelet nadirs in patients with breast cancer following chemotherapy and is 

well tolerated in a phase I trial.MK endoreduplication, Administration of recombinant human 

IL-11 (rhIL-11) led to an increase in both the frequency of megakaryocytes (MKs) and the 

proportion of MKs expressing proliferating cell nuclear antigen (PCNA) in the bone marrow 

of these patients. In two randomized, placebo-controlled phase II clinical trials involving cancer 

patients with severe thrombocytopenia, treatment with rhIL-11 notably reduced the number of 

patients requiring platelet transfusions compared to those given a placebo [7] [8] 

Additional preclinical research using rhIL-11 in both normal and myelosuppressed animals has 

demonstrated the cytokine's thrombopoietic capability. Peripheral platelet counts have been 

demonstrated to rise when rhIL-11 is administered to healthy animals, such as mice, rats, 

rabbits, dogs, and nonhuman primates.  [7] With typical granule production and demarcation 

membrane system development, the mature MKs that form in the animals' BM appear ultra 

structurally normal. Mice given rhIL-11 subcutaneously on a regular basis showed an increase 

in colony-forming unit-MK (CFU-MK) numbers in the spleen and median MK ploidy in the 

BM.  [9]. RhIL-11 therapy enhanced platelet nadirs and sped up platelet recovery in 

myelosuppressed mice. These effects were accompanied by a significant rise in the number of 

BM MKs. [10] [11] 

RhIL-11's actions on MK-line hematopoietic cells in vitro are consistent with its effects in vivo. 

It has been demonstrated that rhIL-11 promotes several phases of MK development.  [12] [13] 

[14] RhIL-11 worked in concert with IL-3 or steel factor (SF) to promote growth of human and 

murine CFU-MK-derived colonies.  Human CD34+HLA-DR− BM cells treated with rhIL-11 

in addition to IL-3 showed improved colony formation derived from burst-forming unit-MK 

(BFU-MK).  Compared to IL-3 alone, rhIL-11 with IL-3 enhanced MK number and 

acetylcholinesterase synthesis in murine BM liquid cultures. RhIL-11 alone increased the 

ploidy and growth of human BM MKs. 

IL-11 belongs to the cytokine family, which also includes IL-6, ciliary neurotrophic factor 

(CNTF), leukemia inhibitory factor (LIF), and oncostatin M (OSM)). These are regulated by 



3  

the same signal transducer, gp130, which has ubiquitous expression in many tissues and cell 

types.  [15] The specificity-granting element of the receptor complex is the recently cloned 

ligand-binding IL-11 α chain. Cytokine stimulation triggers the interaction between the α chain 

and gp130, leading to the activation of signaling pathways involving the JAK/TYK tyrosine 

kinases and the MAPK serine/threonine kinases. This activation results in the phosphorylation 

of transcription factors STAT1 and STAT3. [16]. 

 

1.3 Role of excipients in protein based -drug delivery  

Excipients can be utilized to minimize surface adsorption, inhibit protein aggregation, stabilize 

proteins, or just provide normal osmolality. A vast range of compounds are included in the 

stabilizers, including as sugars, salts, polymers, surfactants, and amino acids. These excipients 

interactions with the protein, the container surface, and—above all—water is what primarily 

affect the stability of proteins in solution. [17]While some excipients employ a number of 

essentially distinct methods via indirect interactions, others use direct binding to stabilize 

proteins in solution. Since water is no longer present in the prohibited state, any effects that the 

excipients may have on proteins through their interactions with it are meaningless. Instead, 

excipients contribute to protein stability by directly interacting with them. 

 Many proteins change their shape and become unstable when they are in a solution. Because 

of this, they can be affected by different types of stress during steps like purification, 

processing, and storage  [18] [19]. Shear strain, exposure to high pH, surface adsorption, and 

high temperatures are some examples of these stresses  [20]. As a result, a variety of processes 

may cause protein-based medications to physically degrade (e.g., unfold, aggregate, and form 

insoluble particles), which may hurt the therapeutic product's safety and effectiveness. The 

stability of the protein is largely determined by its solvent environment [21] 

Studies have shown that specific solvent additives, commonly referred to as osmolytes, can 

enhance protein stability and thereby reduce the aggregation of proteins with moderate 

stability. In this context, cosolvents help maintain the native structure of proteins and reduce 

aggregation by stabilizing the folded state, as protein unfolding typically precedes aggregation 

[22]. Their effectiveness stems from poor compatibility or repulsive interactions with the 

protein surface. Conversely, excipients such as proteins, polymers, arginine, and surfactants 

are commonly used to minimize protein aggregation without necessarily enhancing overall 

stability [23]. These agents function either by competitively binding to surfaces or interfaces 

that may destabilize the protein or by forming weak interactions with the protein surface [24]. 
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Certain excipients are also employed to stabilize proteins in their dried form. However, the lack 

of water in this state alters the underlying mechanisms, rendering excipient-water interaction-

based stabilization ineffective. Additionally, since freezing is a critical intermediate step in the 

lyophilization process, its influence on protein stability in the presence of various additives will 

also be discussed. Notably, the freezing stage presents a unique physical environment, marked 

by contact forces within the solution, as water remains initially but is progressively removed 

during ice crystal formation. 

1.4 In Silico Modeling in Excipient Screening 

In silico approaches have become increasingly popular in pharmaceutical sciences, notably in 

protein formulation creation. The stability and efficacy of protein-based treatments depend on 

the prediction and analysis of protein–excipient interactions, which may be done 

computationally using molecular docking and molecular dynamics simulations.  

Excipient selection has traditionally relied on time-consuming, expensive, and tedious 

experimental trial-and-error techniques. To get over this limitation, current research has 

focused on computational forecasting of excipient binding sites and interaction architectures 

with therapeutic proteins. In addition to identifying which excipients should be given 

experimental priority, these methods offer significant insight into molecular details of how 

excipients affect protein structure and stability. 

Research [25] employed techniques such as hydrogen-deuterium exchange mass spectrometry 

(HDX-MS) alongside molecular docking to investigate how typical excipients interact with 

granulocyte colony-stimulating factor (G-CSF). A combined mechanism of selective exclusion 

and specific binding that can help in protein stabilization is achieved by the Insilco study's 

identification of hotspot regions on the protein surface where excipients mainly attach. This 

method showed that the configuration and type of interaction between excipients and protein 

surfaces may be predicted using in silico docking. To systematically map excipient interactions 

with different therapeutic proteins, Rathore et al. (2016) [26] conducted docking experiments. 

These findings revealed that excipients generate non-covalent interactions with certain amino 

acid residues via hydrogen bonding, electrostatics, and van der Waals forces, which stabilize 

the protein structure and avoid aggregation. In order to enhance formulation, scientists select 

excipients that improve product stability while maintaining biological activity.  

Their study underlined the need to find interaction hotspots. A computational method was 

proposed by Sahakyan et al. (2024) [26] in another recent work to predict the impact of 
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excipients on protein–protein interactions, specifically their ability to change aggregation 

tendencies. To understand how excipients affect the protein's interaction structure, the study 

extended in silico screening beyond straightforward protein–excipient docking. It recognizes 

the relevance of computational modelling for both logical formulation optimization and 

interaction prediction. 

Together, these studies illustrate the growing use of in silico modelling for excipient testing. 

This highlights how techniques like interaction fingerprinting, energy reduction, and molecular 

docking are changing excipient selection from an experimental method procedure to a 

predictive, data-informed strategy. Computational techniques have laid the groundwork for 

logical excipient design, greatly speeding up the development of reliable and efficient protein-

based medicines. 

1.5 Molecular Docking as a Computational Tool 

Molecular docking is essentially the process of employing computers to simulate ligand-protein 

interactions within the protein's three-dimensional binding region. The most energetically 

advantageous binding orientation of a ligand within the protein's binding pocket may be 

predicted by docking programs using algorithms that take into consideration variables 

including ligand flexibility, protein conformational variations, and electrostatic 

complementarity  [27]. 

The quality of the protein structure, the selected scoring function, the inclusion of solvent 

effects, and the flexibility of the protein are some of the factors that affect the accuracy of 

molecular docking simulations [28] . Additionally, to evaluate the predicted accuracy of 

docking algorithms, validation with experimental data, such as crystallographic structures or 

binding affinity measurements, is crucial. 

Molecular docking has emerged as a useful tool in virtual screening attempts to identify 

potential therapeutic molecules from enormous libraries of chemicals, despite its high 

processing needs. Scientists may find the most promising candidates for further experimental 

validation by virtually screening millions of chemicals. Enhance the drug development process 

and lower the time and expense involved with traditional high-throughput screening 

techniques. 

In silico methods, such as molecular docking, represent a valuable option through the ability 

to predict binding affinity and contact sites between proteins and excipients with high accuracy 
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[29]. The present research investigates the interactions of therapeutic IL-11 with typical 

pharmaceutical excipients through molecular docking simulations. This study utilizes 

molecular docking to evaluate the binding interactions between IL-11 and a panel of commonly 

used excipients, namely lactose, sucrose, trehalose, mannitol, and sorbitol, to predict their 

potential to stabilize IL-11 through favorable interactions. 

 

1.6 Research Objectives and Scope 

The core objective of this study to explore and evaluate the interactions between the therapeutic 

protein Interleukin-11 (IL-11) and selected pharmaceutical excipients using computational 

molecular docking techniques. The intent is to identify potential excipients that can interact 

favourably with IL-11, thereby suggesting their stabilizing roles in its formulation. 

The specific objectives of this study are: 

To retrieve and prepare the three-dimensional (3D) structure: of human IL-11 for in silico 

docking. 

To select and optimize excipient molecules: that are commonly used in biopharmaceutical 

formulations. 

To perform molecular docking simulations: using Auto Dock Vina or a similar tool to 

predict binding affinities and interaction sites between IL-11 and the selected excipients. 

To analyse the docking results: to identify key amino acid residues involved in binding and 

the nature of non-covalent interactions. 

To interpret the implications of these interactions: in terms of protein stabilization, with 

potential recommendations for formulation design. 

This study is limited to the use of in silico methods to investigate the interactions between the 

therapeutic protein Interleukin-11 (IL-11) and selected pharmaceutical excipients. It does not 

involve any experimental or laboratory-based work but relies solely on computational tools 

such as molecular docking to predict potential binding interactions. The excipients chosen for 

this study are commonly used stabilizers in protein formulations, including amino acids, sugars, 

and polyols. The primary focus is on identifying the binding affinity and nature of interactions 

between IL-11 and these excipients, with the aim of understanding their possible roles in 

stabilizing the protein structure. The docking results are interpreted to highlight key residues 

involved in excipient binding, which can provide valuable insights into formulation strategies. 
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However, this study does not assess the functional activity, stability under various storage 

conditions, or in vivo behavior of the protein–excipient complexes. The findings are intended 

to support the early phase of formulation development by providing a computational basis for 

excipient selection, and they serve as a foundation for future experimental validation. 
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CHAPTER 2 

 

Literature Review 

 

 

Stability Challenges of Biotherapeutics 

Biotherapeutic proteins like monoclonal antibodies, cytokines, and growth factors are 

extremely sensitive to processing and environmental conditions because they possess large and 

complex structures. The molecules are prone to different types of degradation mechanisms, 

like physical instabilities involving aggregation and precipitation and chemical modifications 

involving deamidation, oxidation, hydrolysis, and disulfide bond reshuffling. Among them, 

protein aggregation is particularly significant since it can cause loss of activity and can induce 

harmful immune reactions in patients  [31] [33]. 

Instability may arise in any stage of the product life cycle—from cell culture and purification 

to formulation, storage, and transportation. All of these may involve various destabilization 

factors such as temperature variations, exposure to light, pH variations, agitation, and freeze–

thaw cycles, which destabilize the conformation of the protein and cause partial unfolding and 

hydrophobic patch exposure, thus triggering the aggregation process (RSC Advances, 2023; 

Pharmaceutics, 2022) [34]. In addition, popular surfactants such as polysorbates, even though 

widely employed to avoid agglomeration, have proven to be limiting as they are prone to 

oxidation and hydrolysis, leading to the investigation of other excipients (Pharmaceutics, 2022) 

[34]. 

To counter these challenges, early evaluation of "stability liabilities" within the drug 

development stage of protein structure has been suggested. These involve testing regions that 

are susceptible to oxidation or deamidation with in silico tools and biophysical tests, allowing 

for rational design of formulation (Sharma et al., 2020) [32]. Stabilization measures can include 

protein engineering, optimal storage conditions, or the employment of novel stabilizers like 

amino acids, polyols, and sugars. 

Molecular docking is a very potential computer-based tool for predicting the binding 

interactions between small molecules (ligands) and selected proteins, such IL-11, with high 

accuracy and efficiency (Morris et al., 2009) [35]. By simulating excipient-protein interactions 
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within the three- dimensional space of the protein's surface, docking programs can predict the 

favourable complex confirmation of a ligand, facilitating for development of pharmaceutical 

and further experimental validation. Despite its computational nature, molecular docking has 

proven to be a valuable tool in virtual screening campaigns aimed at identifying potential drug 

candidates from large chemical libraries. 

2.1 Excipient-protein interactions: mechanism and implications  

The efficacy and stability of biotherapeutic proteins are greatly determined by the type of 

excipients present in their formulation. Excipients are not inert materials; they actively 

destabilize or stabilize proteins through various physical and chemical modes of interaction. 

These interactions are important to inhibit degradation processes such as aggregation, 

unfolding, and oxidation that can lead to loss of quality and therapeutic efficacy of protein 

drugs  [36]. 

One of the most prevalent mechanisms is preferential exclusion or hydration. During this 

action, excipients like sugars (e.g., sucrose, lactose and trehalose) and polyols (e.g., glycerol) 

are kept out of the protein's immediate surroundings. This thermodynamically Favors the 

protein's compact, native structure, thus raising its structural stability (Wang, 1999) [37]. As 

an example, trehalose is commonly incorporated in freeze-dried products for its more effective 

water replacement and glass transition characteristics that maintain protein structure upon 

drying  [36]. 

Conversely, certain excipients like arginine and histidine have direct binding interactions with 

proteins. These involve hydrogen bonding, π-π stacking, or hydrophobic interactions with 

amino acid side chains on the surface of the protein. These interactions can cover exposed 

hydrophobic areas and hinder the aggregation tendency of proteins, particularly under agitation 

or freeze– thawing. However, high concentrations of arginine may sometimes destabilize 

proteins, highlighting the importance of concentration optimization in formulation design  [38]. 

Additionally, electrostatic interactions with charged excipients and protein surface residues can 

also influence their conformational stability substantially. For example, incorporation of 

buffering agents such as histidine not only controls pH but will also bind to specific protein 

residues and stabilize tertiary structure  [36]. Besides, surfactants like polysorbate 20 or 80 are 

usually added to reduce interfacial stress and surface adsorption, two primary inducers of 
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protein aggregation in vials and syringes. These surfactants shield proteins from air–liquid 

interface denaturation, although they are also susceptible to oxidative degradation  [39] 

Recognition of these interactions enables formulation scientists to design excipients 

strategically to improve overall stability. For instance, a blend of sucrose and polysorbate will 

at the same time confer thermal stability and mitigate interfacial stress. But poor choice or 

undue excipient load may result in unforeseen adverse outcomes such as higher viscosity or 

solubility problems (Wang et al., 2010) [39]. Thus, detailed biophysical and computational 

evaluations of protein–excipient compatibility are critical in early-stage formulation. 

 

2.2 IL-11: Structure, Function, and Biomedical Applications  

Interleukin-11 (IL-11), a multifunctional cytokine within the IL-6 family, plays a vital role in 

tissue repair, immune regulation, and hematopoiesis. Structurally, IL-11 is a 19 kDa 

glycoprotein characterized by a four-helix bundle motif common to all IL-6 family members. 

This structural feature enables IL-11 to interact with the shared signal-transducing receptor 

gp130 and the IL-11 receptor α (IL-11Rα), triggering downstream signaling pathways  [41]. 

The main function of IL-11 is to promote the proliferation and maturation of hematopoietic 

progenitor cells. Let me know if you'd like it expanded into a full sentence or used in a specific 

context, particularly megakaryocytes, which are the building blocks of platelets. Because of 

this characteristic, recombinant IL-11 is a useful therapeutic treatment for treating 

thrombocytopenia, or decreased platelet counts, in patients after bone marrow transplantation 

or chemotherapy  [42]. Furthermore, IL-11 is important in reducing inflammatory and 

autoimmune illnesses because it modulates cytokine production to provide anti-inflammatory 

effects  [43]. 

IL-11 is essential for tissue remodelling and repair processes in addition to haematopoiesis. By 

lowering epithelial cell apoptosis and increasing regeneration, it has been linked to accelerating 

wound healing and safeguarding epithelial tissues, such as the lungs and gastrointestinal tract  

[44]. Nevertheless, pathological fibrosis and the advancement of cancer have also been 

connected to aberrant IL-11 signalling, suggesting the necessity of precise therapeutic control  

[45]. 

Because of its numerous biological functions, IL-11 is an attractive target for both therapeutic 

intervention and drug discovery. Presently, recombinant IL-11 formulations are being used in 

clinical settings, and research is being conducted to enhance their stability, bioavailability, and 
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immunogenicity by using sophisticated formulation techniques (O'Neill et al., 2020). Thus, 

improving the therapeutic efficacy of IL-11 requires the capacity to comprehend and modify it 

at the molecular level. This emphasizes the significance of in silico research, such as molecular 

docking analyses, to find excipients that can stabilize IL-11 during formulation. 

  

2.3 Molecular Docking Methods and Applications in Drug Discovery 

 Docking is a computational approach extensively utilized in drug discovery to forecast how 

small molecules (ligands) interact with target proteins. Its applications include lead compound 

identification, optimization, virtual screening, and structure-based drug design. The method 

involves simulating the geometric complementarity and non-covalent interactions between the 

ligand and receptor within the binding site, thereby predicting the most energetically favorable 

binding pose and affinity. 

Several molecular docking algorithms have been developed, each with its unique features and 

strengths. Among the most widely used are Auto Dock, Auto Dock Vina, and DOCK, which 

employ different scoring functions and search algorithms to explore ligand conformational 

space and optimize ligand-receptor interactions. These programs incorporate various 

parameters such as ligand flexibility, protein flexibility, and solvent effects to improve the 

accuracy and reliability of docking predictions. 

Molecular docking has various applications in drug discovery, including lead identification, 

where it can efficiently screen large chemical libraries to identify potential ligands with high 

binding affinity and specificity for the target protein. Virtual screening, another key 

application, involves docking a database of compounds against a target protein to prioritize 

promising candidates for experimental testing based on their predicted binding energy and fit 

within the binding site. 

Molecular docking plays a crucial role in structure-based drug design by facilitating the 

prediction of ligand–target interactions guide the rational optimization of lead compounds by 

systematically exploring the chemical space around the binding site and identifying key 

interactions driving ligand binding and potency. Docking simulations can also aid in 

understanding structure-activity relationships and predicting the impact of chemical 

modifications on ligand binding affinity and selectivity. 

Moreover, molecular docking serves as a valuable tool for studying protein- ligand interactions, 

elucidating the molecular mechanisms underlying drug action and resistance, and guiding the 

design of novel therapeutic agents targeting various disease pathways.  
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2.4 Computational approach in Drug Discovery 

The development of stable and efficient biotherapeutic formulations is a difficult and resource-

intensive process. Computational techniques have become indispensable tools for formulation 

design, offering a quick and effective alternative to lengthy experimental testing. Enhancing 

stability, solubility, and bioavailability requires a molecular-level understanding of protein 

interactions and behaviour with excipients, which these approaches provide  [46]. 

Quantitative structure-activity relationship (QSAR) modelling, molecular docking, and 

molecular dynamics (MD) simulations are crucial computational techniques for predicting and 

analysing protein–excipient interactions. In order to guide the selection of excipients that may 

enhance protein stability, molecular docking helps identify potential binding sites and 

interaction energies between proteins and small molecules  [47]. The dynamic behaviour of 

protein-excipient complexes over time may also be seen thanks to MD simulations, which 

display atomic-scale stabilizing interactions and conformational change [48]. 

Furthermore, methods for machine learning and artificial intelligence (AI) are evolving to 

predict formulation outcomes through the analysis of large datasets of excipient properties and 

protein stability. By identifying patterns and recommending optimal excipient combinations, 

these data-driven approaches reduce the amount of trial-and-error involved in formulation 

development. Researchers may proactively evaluate the resilience of formulations by using 

computational modelling to simulate stress elements such as temperature, pH, and mechanical 

agitation  [49]. 

Combining computational tools and experimental methodologies accelerates the creation of 

formulations with improved stability and efficacy. The rational design of biotherapeutics 

tailored to specific clinical needs is made possible by this partnership, which also reduces 

development costs and time. With continued developments in computer power and algorithms, 

these technologies are expected to play an increasingly more important role in future 

biopharmaceutical formulation strategies. 
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CHAPTER 3 

 

METHODOLOGY 

 
This study utilizes molecular docking to evaluate the binding interactions between IL-11 and a 

panel of commonly used excipients, namely lactose, sucrose, trehalose, mannitol, and sorbitol, 

to predict their potential to stabilize IL-11 through favorable interactions. Here, we used PyRx 

for virtual screening of multiple excipients (ligands) targeting rhIL-11. The following 

paragraphs detail the approach utilized for ligand selection, protein preparation, molecular 

docking, and validation procedures. 

 

3.1 Protein structure retrieval and preparation  

• The 3D structure of the therapeutic protein interleukin-11 (IL-11) was retrieved  

From the AlphaFold Protein structure Database. The predicted structure was produced from 

the AlphaFold2 deep learning model created by DeepMind and EMBL-EBI. UniProt ID 

[P20809 for human IL-11] was employed to download the model. 

• The prediction confidence for every residue was eliminated using the pLDDT scores 

provided. Regions with low confidence were visually checked and, if necessary, were removed 

from docking studies to maintain the reliability of interaction predictions.  

• Using Auto Dock Tools, all water molecules and heteroatoms were removed. Polar 

hydrogens and Gasteiger charges were assigned. The protein was stored in PDBQT format for 

docking. 
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Fig 3.1: Screenshot showing loading of protein in Auto Dock 4.0 

 
 

 

 
Fig 3.2: Screenshot showing protein after modification 
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1. Download the ligand 

Visit PubChem at www.pubchem.ncbi.nlm.nih.gov. 

• 3D Structures of lactose, sucrose, trehalose, mannitol, and sorbitol ligan- ds were fetched 

from PubChem (https://pubchem.ncbi.nim. nih.gov/in) in SDF format and were converted into 

PDBQT format using Auto Dock Tools. 

• Geometry optimization and torsion tree definitions were applied to prepare flexible ligand 

 

2.Performing docking using pyrx 

Autodock Vina will be the docking tool that we use. We use the Vina algorithm to dock it in 

Pyrx. Launch Pyrx GUI and followed the steps given below: 

2.1Protein Loading 

• Select "File" -> "Load Molecule" or simply click the first icon in the upper left corner. Choose 

the protein structure that you downloaded. referred to here as "IL-11_AF" 

• Convert pdb format of protein to pdbqt by right clicking on IL-11_AF then on display and 

now select macromolecule. 

 
Fig 3.3: Screenshot showing conversion of protein file pdb to pdbqt 

 

http://www.pubchem.ncbi.nlm.nih.gov/
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Fig 3.4: Conversion of protein file pdb to pdbqt 

 

2.2 Ligand loading 

• In PyRx, click on OpenBabel and select on insert new item present on bottom right corner. 

• Now select each ligand from folder one by one and upload it. 
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Fig 3.5: Screenshot showing loading of ligands 

  

• After uploading all ligands, right click on ligand and select minimise all to decrease 

the energy. 

 

 
 Fig 3.6: Screenshot showing minimization of energy of ligand 
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• Again right click and select convert all to AutoDock ligand (pdbqt) to convert all ligands to 

pdbqt format. 

 

 
Fig 3.7: Screenshot showing conversion of all ligands to pdbqt 

 
Fig 3.8: Screenshot showing display of all ligands
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3 Defining ligands and proteins 

The loaded protein and ligand are shown under the "Molecules" tab. It is now necessary to 

identify which is a ligand and which is a protein. • Right-click on the protein –> “Autodock” –

> “Make Macromolecule” to accomplish that. 

Perform a right-click on the ligand, select "Autodock," then "Make Ligand."After that, you'll 

see that it has automatically prepared their PDBQT files under the 'Autodock' page. 

 

 

 
Fig 3.9:  Screenshot showing grid box 

4 Defining grid box 

• Now click on Vina Wizard and select start option on bottom right corner. Start selecting 

protein and ligand one by one by pressing shift and control button. 

• Click on forward. Grid box appears. Return to the 'Molecules' tab located on the right-hand 

side. Click the loaded protein's "+" symbol. 

• All of the residues in the chain will be visible to you. To choose the binding 

residues, right-click on the residue and choose Atoms, Display, Label, and Atoms. The atoms 

will start to show up on the protein. Now make the appropriate adjustments to the 

grid box so that it contains all of the selected residues. The ligand does not need to be enclosed 

within the grid box. 
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Fig 3.10: Screenshot showing defining of grid box 

 

5 Running vina for docking 

• To adjust the exhaustiveness, simply enter the desired number in the box located in the left-

bottom corner. Once everything has been adjusted, press the "Forward" button. 

• Docking will begin, and the processing will be shown. The bottom panel will display the 

poses and their binding affinities after the docking process is complete. It will show all poses 

along with RMSD values. Save your file in excel sheet. 

• Now analyze the result and the one ligand which has the highest energy with negative sign is 

selected. Again, open pyrx tab and click on Auto Dock and select macromolecule and select 

the ligand with highest binding energy. Now right click and select display then all models of 

the ligands get displayed and select your desired model and save it in pdb format. 
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Fig 3.11: Screenshot showing running of vina wizard 

 

 

 
Fig 3.12: Screenshot showing binding affinity of ligands with protein 
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6 Open Discovery Studio: - Start a new project in Discovery Studio. 

7 Protein Structure Import: 

• Open Discovery Studio and import the structure of the target protein. 

• Choose your protein structure file (such as *.pdb) by using File > Open. 

 

 

 

 

 
Fig 3.13: Screenshot showing visualization of protein structure in discovery 

studio 
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8 Import Docked Ligand Conformations: 

• Import the docked ligand conformations. 

• Use File > Open and select the converted ligand file (e.g., *.pdb or *.mol2). 

 

 

 
Fig 3.14: Screenshot showing structure of Lactose
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9 Visualize Docked Poses: 

• Display the protein and ligand together in the 3D workspace. 

• Use the View > Sequence panel to ensure the correct structures are loaded. 

• Adjust the display settings to show interactions clearly (e.g., stick or surface representations). 

 

 

10 Analyse Binding Affinities: 

• Check the binding affinities associated with each docked pose. 

• This information can be found in the PyRx log files or the output summary from PyRx. 

• Record the binding affinity scores (typically in kcal/mol) for reference. 

 

11 Examine Binding Interactions: 

• Use the Analyze > Receptor-Ligand Interactions tool to identify and visualize key 

interactions between the ligand and the protein. 

• Highlight hydrogen bonds, hydrophobic interactions, salt bridges, and π-π stacking 

interactions. Check for consistency with known binding sites or important residues in the 

binding pocket. 
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12 Evaluate Docked Poses: 

• Compare multiple docked poses to determine if there is a consensus binding mode. 

• Use the View > Compare tool to overlay different conformations and evaluate their 

similarity. 

• Consider the Root Mean Square Deviation (RMSD) values to understand the variance among 

poses. 



26  

CHAPTER 4 

 

 

RESULT 

 

The binding affinities (kcal/mol) between IL-11 and various pharmaceutical excipients are 

summarized in the table below: 

EXCIPIENTS BINDING AFFINITIES (KCAL /MOL) 

LACTOSE  -6.1 

SUCROSE  -6.0 

TREHALSOSE -5.8 

MANNITOL  -5.1 

SORBITOL -4.5 
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Fig 4.1: Screenshot showing Binding Affinities 

 

These results indicate that lactose exhibited the strongest binding to IL-11, closely followed 

by sucrose and trehalose. In contrast, mannitol and sorbitol displayed weaker interactions, 

suggesting a reduced potential for stabilizing the protein. 

Molecular docking showed that lactose (–6.1 kcal/mol), sucrose (–6.0 kcal/mol), and trehalose 

(–5.8 kcal/mol) had stronger binding affinities with IL-11 compared to mannitol (–5.1 

kcal/mol) and sorbitol (–4.5 kcal/mol). Disaccharides formed multiple hydrogen bonds with 

key IL-11 residues, suggesting better surface interaction and potential stabilizing effects. In 

contrast, sugar alcohols showed weaker interactions, indicating less effectiveness as stabilizers.
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Docking of different excipients with IL-11 

Docking of IL-11 with lactose 

Docking results in binding between IL-11 and Lactose shows 

E score=1024.97, binding affinity -6.1 kcal/mol and rmsd value =0 

 

 
Fig 4.2: screenshot showing binding of excipient with excipient 

 

 
Fig 4.3: 2D and 3D representations of IL–11–lactose complex. Lactose binds to IL-11 

via multiple hydrogen bonds (ARG61, GLY68, HIS182) and carbon-hydrogen bonds 

(ASP69, LEU183), indicating strong surface interaction. One unfavorable interaction 

with HIS70 is present but does not significantly affect overall binding stability. 
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Docking of IL-11 with Sucrose  

Docking results in binding between IL-11 and Sucrose shows E score= 288.57, binding affinity 

-6.0kcal/mol and rmsd value 0 

 

 

Docking of IL-11 with Trehalose  

Docking results in binding between IL-11 and Trehalose shows E score= 288.57, binding 

affinity -5.8 kcal/mol and rmsd value 0 

 

 

 

 

 

 

Fig 4.4: 2D and 3D representations of IL-11–sucrose complex Sucrose interacts with IL-

11 through hydrogen bonds with ASN71, HIS70, and LEU78, and van der Waals 

interaction with ASN71 suggesting stable surface binding 

 

Fig 4.5: 2D and 3D representations of the IL-11–trehalose complex. Trehalose forms a 

strong hydrogen bond with HIS70, and GLY179 shows van der Waals interaction 

indicating potential surface stabilization 
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Docking of IL-11 with Mannitol  

Docking results in binding between IL-11 and Mannitol shows E score=407.16, binding affinity 

–5.1kcal/mol and rmsd value 0 

 

 

 

Docking of IL-11 with Sorbitol  

Docking results in binding between sorbitol with IL-11 shows E score=1054.96, binding 

affinity -4.5kcal/mol and rmsd value 0 

 

  

 

Fig 4.6: 2D and 3D representations of the IL-11–mannitol complex Mannitol forms a 

conventional hydrogen bond with SER81, suggesting moderate surface interaction 

Fig 4.7: 2D and 3D representations of the IL–11–sorbitol complex showing [Sorbitol 

forms strong conventional hydrogen bonds with HIS70 and HIS175, van der Waals 

interaction with ARG61 
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                                              Discussion 

Blending sugar excipients with therapeutic proteins can improve their stability, dissolution as 

well as acceptability by the patients. In the current study, excipient-IL-11 molecular 

interactions were analyzed computationally using molecular docking. The excipients analyzed 

included sugar and sugar alcohols. Both sugars and sugar alcohols were capable of forming 

non-covalent interactions with IL 11, as reflected by their binding affinities (Table 1). 

However, disaccharides such as lactose, sucrose, trehalose showed more favorable binding 

energies as compared to sugar alcohols, mannitol and sorbitol. This might be due to the ability 

of sugars to form multiple hydrogen-bonds with polar and charged protein surface residues, as 

represented in Fig. 1, 2. The relatively lower affinities of mannitol and sorbitol might be due 

to their poorer capacity to form extensive hydrogen-bonding networks with the protein surface 

and being less favourable to IL-11 stabilization. Thus, the formulation stability of IL-11 can be 

improved by blending it with sugars excipients. A strategy involving the combination of sugar 

excipient-stabilized therapeutic proteins such as IL-11 with other excipients such as amino 

acids and polyols could be more effective. Our findings were in corroboration with the 

stabilization of therapeutic proteins for lyophilization and storage  [50]. Shao et al. (2004) 

showed that disaccharides such as trehalose and sucrose inhibit aggregation and maintain the 

secondary structure of IL-11. IL-11 formulations in U.S. Patent US6270757B1 also contained 

stabilizers like sugars and polyols. The concurrence of docking predictions with experimental 

data confirms the validity of this computational screening method. 

 

Recommendations for Future Research 

Interleukin-11 (IL-11), a cytokine of therapeutic relevance is blended with excipients in order 

to prevent protein aggregation and to enhance stability. Unlike standard practices that deem 

excipients to be inert substances, the present study explored their molecular interactions with 

the protein surface. The results established that disaccharides lactose, sucrose, and trehalose 

bound more favorably with IL-11 than sugar alcohols. This owed to their ability to create stable 

hydrogen bonds with functional surface residues. 

These findings are not only of scientific significance but also of immediate practical utility, as 

these represent a predictive and economical means of selecting excipients to stabilize proteins. 

Through the integration of computational methods into the initial stages of formulation, the 

process has the potential to minimize reliance on high-throughput experimental screening and 

facilitate the development of stable therapeutic protein formulations. The procedure can be 
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applied to other biologics as well, thus being a valuable addition to the design of 

biopharmaceutical formulations. Docking simulations, when integrated with both 

computational and laboratory-based techniques, help to accelerate drug discovery, minimize 

research expenses, and improve the effectiveness of lead compound refinement, and 

spectroscopy techniques would be required to confirm and supplement the computational 

results. 
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